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Experiment 1: Block Diagram Simulation 
 
 
 
 
 
 
 
 
 
 
1 Introduction 
 
MATLAB is a high-performance standard tool for design, simulation and analysis of 
dynamical systems in control engineering. 
SIMULINK, an extension toolbox for MATLAB, provides a graphical user interface (GUI) 
for building linear and nonlinear system models as block diagrams.  
The SIMULINK libraries provide single block components, for example signal sources, 
transfer functions and scopes, which can be used to create your own system, called “model”. 
The single block components are copied into your model by drag and drop operations. 
After connecting the blocks appropriately and setting up the simulation and block parameters, 
the simulation can be started. 
 
 
 

University of Siegen 
Department of Electrical Engineering and Computer Science 

Institute of Automatic Control Engineering 



 2 

2 Simulation with MATLAB and SIMULINK 
 
2.1 Starting MATLAB and SIMULINK, creating a new model 
 

Start MATLAB by double-clicking the MATLAB-icon  on the Windows desktop or by 
using the Windows “Start”-menu (Start → Programme → MATLAB x.y → MATLAB x.y). 
A Window with the MATLAB-Desktop opens up. A possible appearance of the MATLAB-
desktop is shown in figure 1. 
 

 
 

Figure 1: The MATLAB-desktop 
 
Now SIMULINK can be started by entering the command “simulink” into the “Command 
Window” or clicking the SIMULINK-icon  in the toolbar below the menu. 
 
SIMULINK starts by opening up the “Simulink Library Browser”-window shown in figure 2 
(see next page). 
 
The upper part of the window contains a description of the selected group or block. The lower 
left part of the window contains the groups and subgroups of blocks organized in a tree view. 
The single block components can be found in the lower left part of the window. 
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Figure 2: The SIMULINK library browser 
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Now start creating a new “model”. Click the “Create a new model”-icon  in the toolbar 
below the menu or use the menu itself (File → New → Model). 
 
The “Model”-window opens up. Figure 3 shows the Model-window that already includes the 
“Step”-block from the “Simulink / Sources”-library. 
 

 
 

Figure 3: “Model”-window with “Step”-block 
 
The single block components from the “Simulink Library Browser”-window can be copied to 
the “Model”-window using drag & drop. 
 
 
2.2 Connecting blocks 
 
Two blocks can be connected with each other by clicking the input or the output of one of the 
blocks, holding down the mouse button, moving the cursor to the corresponding output or 
input of the second block and releasing the mouse button. 
You can draw a line with a vertex by releasing the mouse button when the connection is 
incomplete. From the point where you released the button it is possible to continue the line. 
If you want to draw a branching point, position the cursor on the line, where you would like to 
have the branching point. Press and hold down the right mouse button. Move the cursor to the 
input of the block and release the mouse button. 
 
 
2.3 Specifying block parameters 
 
After a double-click on a block, a parameter or display window for the corresponding block 
opens up. The following text lists important blocks and their (important, not all) parameters. 
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2.3.1 “Step”-block (Library: Simulink / Sources) 
 
 Parameters: Step time (s) 
 Initial value 
 Final value 
 
 
2.3.2 Transfer Function: “Transfer Fcn”- block (Library: Simulink / Continues) 
 

A transfer-function of the form 
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can be realized with this 

block. 
 
 Parameters: Numerator coefficients as a vector: [ ]011 bbbb mm K−  
 Denominator coefficients as a vector: [ ]011 aaaa nn K−  
 
 
2.3.3 “Scope”-block (Library: Simulink / Sinks) 
 
Figure 4 shows an opened scope-block with a toolbar in the upper part of the window. 
 

 
 

Figure 4: Opened scope-block 
 
Functions in the toolbar: (from the left to the right side) 
 

• Print 
• Parameters 
• Zoom 
• Zoom X-axis 
• Zoom Y-axis 
• Autoscale 

• Save current axes settings 
• Restore current axes settings 
• Floating scope 
• Unlock axes selection 
• Signal selection 
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If you choose the “Parameters”-icon, a window opens up with the cards “General” (shown in 
figure 5) and “Data history” (shown in figure 6). 
 

 
 

Figure 5: “General”-card of “Scope” parameters 
 
 

 
 

Figure 6: “Data history”-card of “Scope” parameters 
 
Note: If you are missing calculated data at the beginning of your diagram, remove the hook in 
the check-box in front of “Limit data points to last:”. 
 
The scaling and the title of the diagram can be changed by choosing the point “Axes 
properties” from the pop-up-window (shown in figure 7, next page) that opens up when you 
click on the diagram with the right mouse button. The “Axes properties”-window itself is 
shown in Figure 8 (also on the next page). 
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Figure 7: Pop-up-window for diagram options 
 
 

 
 

Figure 8: “Axes properties window” for axis 1 
 
 
2.3.4 Multiplexer: “Mux”-block (Library: Simulink / Signal Routing) 
 
 Parameter: Number of inputs 
 
 
2.3.5 “Add”, “Subtract” or “Sum”-block (Library: Simulink / Math Operations) 
 

 Parameters: A sequence of plus or minus signs. The number of inputs is equal to the 
number of signs. The position of the inputs is influenced by the 
vertical bar “|”-sign. 

 Icon shape (round or rectangular) 
 
 
2.3.6 “Gain”-block (Library: Simulink / Math Operations) 
 
 Parameter: Gain 
 
 
2.3.7 “Saturation”-block (Library: Simulink / Discontinuities) 
 
 Parameters: Upper limit 
 Lower limit 
 
 
2.3.8 “Integrator”-block (Library: Simulink / Continuous) 
 Parameters: External Reset (none, rising, falling, either, level) 
 Initial condition 
 Limit output (upper and lower saturation limit) 
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2.3.9 “Derivative”-block (Library: Simulink / Continuous) 
 
 
2.4 Running the simulation and printing the results. 
 
Parameters for the simulation can be set by choosing the menu point “Configuration 
Parameters…” from the “Simulation” menu in the model window. The window 
“Configuration parameters” shown in figure 9 will open up. 
 
 

 
 

Figure 9: Configuration parameters for the simulation 
 
 
Change the parameters according to the list below and accept the settings. 
 
 Parameter: “Solver options”, “Type”: Fixed-step 
 “Solver”: ode5 (Dormand-Prince) 
 “Fixed step size”: 0.01 sec 
 
After adjusting the settings, the simulation can be started using the menu (Simulation → Start) 
or clicking on the “start simulation”-button  in the toolbar of the model window. 
 
When the simulation has run, the results can be printed out by clicking onto the “Print”-icon 
in the scope window. Select the “Eigenschaften” (= properties) button and change the paper 
format from “Hochformat” (= portrait format) to “Querformat” (= landscape format). Accept 
all setting and start the print process by clicking the “OK”-button. 
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3 Experiment 
 
3.1 Two second-order systems have to be modelled with “Transfer Function”-blocks. The 

step responses shall be recorded simultaneously. 
 

Given parameters: Transfer function: 
1)(

)()(
22 ++

==
sTsT

K
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sYsG
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 Relation for the damping: 
b
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T
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D
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 Given Values: 18.021 == ss KK  

 22
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2
1 sec36.0== bb TT  

 6.0;1 21 == DD  
 SIMULINK model: see figure 10 
 
Calculate the values for 1aT  and 2aT , set the parameters of the transfer function blocks 
according to your results and start the simulation. Print out the result. 
 

 
 

Figure 10: SIMULINK model for exercise 3.1, 3.2 and 3.3 
 
 
3.2 Recording of step responses like in exercise 3.1, but with different values for damping 
 
Given parameters: Given Values: 05.0;0 21 −== DD  
 All other parameters: see exercise 3.1 
 
 
3.3 Recording of step responses like in exercise 3.1, but with different transfer functions 
 

Given parameters: Transfer functions: 
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 SIMULINK model: see figure 10 
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3.4 Test the transient response and the disturbance rejection of a closed loop control with 
a P-controller. 

 

Given parameters: Controlled system: 
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 Controller (P): cPc KsG =)(  

 sec1.0;
sec
125.1 1 == ssI TK  

 Reference variable: 8.0=w  (Step time:    0 sec) 
 Disturbance variable: 4.0=− d  (Step time: 3.5 sec) 
 Saturation: 1±  
 SIMULINK model: see figure 11 
 
 

 
 

Figure 11: SIMULINK model for exercise 3.4 
 
 
Transfer function of the closed system in figure 11: 
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Record and print out the dynamic transient response disturbance rejection for the system with 
a P-controller for the following parameters: 
 
 
3.4.1 ;2=cPK  Calculate the value for the damping D . 
 
 
3.4.2 ;8.0=D  Calculate the proportional coefficient cPK . 
 
 
3.4.3 ;25.1=D  Calculate the value for cPK . 
 
 
3.5 Test the transient response and the disturbance rejection of a closed loop control with 

a PD-controller. 
 
Extend the controller of the model given in figure 11 with a D-part to get a system with a PD-
controller. Figure 12 shows the complete model. 
 

Given parameters: Controlled system: 
)1(
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 Controller (PD): cDcPc KsKsG +=)(  

 sec1.0;
sec
125.1 1 == ssI TK  

 Reference variable: 8.0=w  (Step time:    0 sec) 
 Disturbance variable: 4.0=− d  (Step time: 3.5 sec) 
 Saturation: 1±  
 SIMULINK model: see figure 12 
 
 

 
 

Figure 12: SIMULINK model for exercise 3.5 
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Transfer function of the closed system in figure 12: 
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Record and print out the dynamic transient response and disturbance rejection for the system 
with a PD-controller for the following parameters: 
 
 
3.5.1 ;;10 1scVcP TTK ==  Calculate the derivative action coefficient cDK . 
 
 
3.5.2 sec;03.0;10 == cVcP TK  Calculate the value for cDK . 
 
 
3.6 Test the transient response and the disturbance rejection of a closed loop control with 

a PID-controller. 
 
Extend the controller of the model given in figure 12 with a I-part to get a system with a PID-
controller. Figure 13 shows the complete model. 
 
 

 
 

Figure 13: SIMULINK model for exercise 3.6 
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Given parameters: Controlled system: 
)1(

)(
1 +

=
sTs

K
sG

s

sI
s  

 Controller (PID): cD
cI

cPc Ks
s

K
KsG ++=)(  

 sec1.0;
sec
125.1 1 == ssI TK  

 Reference variable: 8.0=w  (Step time:    0 sec) 
 Disturbance variable: 4.0=− d  (Step time: 3.5 sec) 
 Saturation: 1±  
 SIMULINK model: see figure 13 (previous page) 
 

For the controller function )(sGc  we use the abbreviations 
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Record and print out the dynamic transient response and disturbance rejection for the system 
with a PID-controller for the following parameters: 
 
 
3.6.1 sec;1.0sec;5.0;10 === cVcNcP TTK  Calculate the derivative action coefficient cDK  

and the integral action coefficient cIK . 
 
 
3.6.2 The same parameters as in exercise 3.6.1, but without saturation of the control variable 

u(t). 
 
 
 
 
 
4 Analysis 
 
4.1 Label the curves recorded in exercise 3.1, 3.2 and 3.3 with the name of the recorded 

function: )(),( 21 tyty . 
 
 
4.2 Enter characteristic variables in the diagrams recorded for exercise 3.1 and 3.3. 
 
Diagram for exercise 3.1: equivalent dead time uT  
 (only for )(1 ty ) build-up time gT  
 steady-state value ( )∞→ty  
 
Diagram for exercise 3.3: integral action coefficient IK  
 time constant 1T  
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4.3 Calculate the step responses )(sYi  for the curves recorded in exercise 3.1, 3.2 and 3.3. 

Use inverse LAPLACE transform to get the corresponding time functions )(tyi . 
 
Note: Appendix B contains a table with some useful LAPLACE transforms. 
 
 
4.4 For exercise 3.4 till 3.6: 
 
Label the recorded curves )(),(),(),(),( tdtutetytw − . 
Enter rise time riset , setting time sett  and overshoot maxy  into the diagrams for a tolerance 
zone of %5± . 
 
 
4.5 For exercise 3.6: 
 
Calculate the reference transfer function )(sGW  and the disturbance transfer function )(sGD  
for the closed loop system (without saturation of the control variable). 
 
Calculate )(sY  considering the reference transfer function )(sGW  and the disturbance transfer 
function )(sGD . Figure 14 shows the superposition of the two components 

)()()( sWsGsY WW =  and )()()( sDsGsY DD = . 
 
 

 
 

Figure 14: The superposition of )()()( sWsGsY WW =  and )()()( sDsGsY DD =  
 
 
Use the superposition and the LAPLACE limit theorem to calculate )(lim ty

t ∞→
 and )(lim te

t ∞→
 with 

and without disturbance. 
 
 
Note: Appendix A contains the LAPLACE limit theorems. 
 
 
 

GW(s)

GD(s)

W(s) 

D(s) 

Y(s)
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5 Comparison of different controller types 
 
Figure 15 shows the block diagram of the given closed loop control. 
 
 

 
Figure 15: Closed loop control 

 
 

Given parameters: Controlled system: 
1

)(
22 ++

=
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ab

s
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 P - Controller: cPcP KsG =)(  
 PD - Controller: cDcPcPD KsKsG +=)(  

 PI - Controller: 
s

K
KsG cI

cPcPI +=)(  

 PID - Controller: cD
cI

cPcPID Ks
s

K
KsG ++=)(  

 Reference variable: 
s

W
sW 0)( =  

 Disturbance variable: 
s

D
sD 0)( =  

 
5.1 Calculate the reference transfer function )(sGW  and the disturbance transfer function 

)(sGD  for all types of controllers (P, PD, PI or PID). 
 
5.2 Use the superposition shown in figure 14 and the LAPLACE limit theorem   

(Appendix A) to calculate )(lim ty
t ∞→

 and the steady-sate error )(lim te
t ∞→

 for each type of 

controller. 
 
5.3 Which of the given controllers (P, PD, PI or PID) are NOT able to avoid a steady-state 

error with the given reference- and disturbance variables? 
 
5.4 What is the important part of the controller that avoids the steady-state error              

(P, D or I)? 
 
 
 

 

Controller 
W(s) Y(s)  

Controlled 
system 

D(s) 
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6 Appendix 
 
6.1 Appendix A: LAPLACE limit theorems 
 
Initial value theorem: )(lim)(lim

0
sFstf

st ∞→→
=

+
 

Final value theorem: )(lim)(lim
0

sFstf
st →∞→

=  

 
 
6.2 Appendix B: Table of LAPLACE transforms 
 
Fundamental functions: 
 

No. )(sF  0),( >ttf  Function name 
1 1 )(tδ  unit impulse 
2 Tse−  )( Tt −δ  shifted unit impulse 

3 
s
1  )(tσ  unit step 

4 Tse
s

−1  )( Tt −σ  shifted unit step 

5 2

1
s

 )(ttσ  ramp 

6 Tse
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−
2

1  )()( TtTt −− σ shifted ramp 

 
 
Further functions: 
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13 
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Advanced Control 
 
 
 

Experiment 2: Simulation of position control 
 
 
 
 
 
 
1 Introduction 
 
The object of the experiment is to analyse the behaviour of different control strategies on one 
controlled system. 
The controlled system, shown in figure 1, consists of two first-order systems and an 
integrator. 
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Figure 1: Block diagram of the controlled system 
 
 

System parameters: 
sec
18.01sec;5.0;1sec;25.0;5.0 2211 ======

sI
sIssss T

KTKTK  

For this controlled system the variables )(1 tx  and )(2 tx  are as important as the controlled 
value )()( 3 txty =  itself. Besides conventional control and cascade control state control is 
tested with the system. 
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2 Simulation with MATLAB and SIMULINK 
 
2.1 Used blocks and their important parameters 
 
This chapter lists only the blocks not mentioned in chapter 2.3 of the instructions for 
experiment 1. 
 
 
2.1.1 “PID Controller”-block (Library: Simulink Extras / Additional Linear) 
 
 Parameters: Proportional: cPK  

 Integral: 
cN

cP
cI T

K
K =  

 Derivative: cVcPcD TKK =  
 
 
2.1.2 Absolute value: “Abs”-block (Library: Simulink / Math Operations) 
 
 
2.1.3 “Product”-block (Library: Simulink / Math Operations) 
 
 
2.1.4 Digital “Display”-block (Library: Simulink / Sinks) 
 
 
2.2 Parameters for the simulation 
 
Select the menu point “Configuration Parameters…” from the “Simulation” menu in the 
model window. The window “Configuration parameters” will open up. 
 
Change the parameters according to the list below: 
 
 Parameter: “Stop time”: 30.0 sec 
 “Solver options”, “Type”: Fixed-step 
 “Solver”: ode5 (Dormand-Prince) 
 “Fixed step size”: 0.006 
 
Figure 2 on the next page shows the configuration parameters window with the correct 
settings. 
 
If a smaller value than 0.006 sec is chosen as the “sample time”, there are more than 5000 
data values for the scope to display. In this case review the “Data history” card in the scope 
parameters window and remove the hook in the checkbox in front of “Limit data points to 
last:”. The correct settings are shown in figure 3 on the next page. 
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Figure 2: Configuration parameters for the simulation 
 
 

 
 

Figure 3: “Data history”-card of “Scope” parameters 
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3 Experiment 
 
The controlled system given in figure 1 will now be equipped with a single PID-controller, a 
cascade control structure and a state controller. 
In order to have a benchmark to compare the different control strategies the control error 
itself, the Integral of Absolute value of Error (IAE) and the Integral of Squared Error (ISE) is 
calculated and displayed. 
 
 
3.1 Standard feedback control system with PID-controller 
 
Examine the transmission behaviour of the closed-loop control consisting of the controlled 
system shown in figure 1 and a PID-controller. The complete MATLAB-model is shown in 
figure 4. 
 
 

 
 

Figure 4: Closed-loop control with PID-controller 
 
 
Record and print the curves for )(tw , )(ty , )(te  and note the final values for IAE and ISE. 
Use the following parameters for the simulation: 
 
Given parameters: Reference value: 1=w  (Step time:   1 sec) 
 Disturbance )(1 tz : ;1)(1 −=tz  (Step time: 10 sec) 
 Disturbance )(2 tz : ;1)(2 −=tz  (Step time: 20 sec) 
 Saturation: 40;40 maxmin =−= uu  

 Controller parameters: sec3.11;
sec
132;40 === cDcIcP KKK  

 
Label the printed curves with the name of the function ( )(tw , )(ty , )(te ). 
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3.2 Cascade control 
 
Examine the transmission behaviour of the closed-loop control consisting of the controlled 
system shown in figure 1 and a cascade control consisting of a PD-controller for the interior 
control loop and a PID-controller for the outer control loop. The complete MATLAB-model 
is shown in figure 5. 
 
 

 
 

Figure 5: Closed-loop control with a cascade controller 
 
 
Record and print the curves for )(tw , )(ty , )(te  and note the final values for IAE and ISE. 
Use the following parameters for the simulation: 
 
Given parameters: Reference value: 1=w  (Step time:   1 sec) 
 Disturbance )(1 tz : ;1)(1 −=tz  (Step time: 10 sec) 
 Disturbance )(2 tz : ;1)(2 −=tz  (Step time: 20 sec) 
 Saturation: 40;40 maxmin =−= uu  
 Controller parameters: 

 outer control loop: sec3.11;
sec
132;40 === coDcoIcoP KKK  

 interior control loop: sec10.0;
sec
10;3 === ciDciIciP KKK  

 
Label the printed curves with the name of the function ( )(tw , )(ty , )(te ). 
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3.3 State control 
 
Examine the transmission behaviour of the closed-loop control consisting of the controlled 
system shown in figure 1 and a state controller. The complete MATLAB-model is shown in 
figure 6. 
 
 

 
 

Figure 6: Closed-loop control with a state controller 
 
 
Equations for the system shown in figure 6: 
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The equations for the system written in matrix form (time domain): 
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The poles of the closed-loop control can be calculated with the equation 
 
 ( ) 0det =+− RBAIs . 
 
with I : identity matrix 
 A : system matrix 
 B : input matrix 
 R : feedback matrix 
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3

21

21
2

21

21
11

212
11

1

23 =+⎥
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The coefficients of the equation above are now compared with the coefficients of the 
following equation: 
 
 ( )( )( ) ( ) ( ) 0321323121321

23
321 =−+++++−=−−− λλλλλλλλλλλλλλλ ssssss  

 
From the comparison and with ωσλ j±=3/2  we get: 
 

 ( )22
13213
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TTT
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1
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s
s
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For 1r , 2r  and 3r  we get (symbolic and with the values of the system): 
 

 
( )

21

2122
1

1

ss

sss

TK
TTTp

r
−−

=  3
2
1

21 −= pr  

 

 
21

11211
2

1

ss

sss

KK
rKTTp

r
−−

=  1
2
1

4
1

212 +−= ppr  

 

 
21

210
3

ss

sIss

KK
TTTp

r =  03 16
5 pr =  

 
 
Calculate the coefficients ( 0p , 1p , 3p ) and the feedback factors ( 1r , 2r , 3r ) for the pole 
placements given in 3.3.1 to 3.3.6. Choose the gain for the reference variable to 3rrw = .  
To avoid a steady-state error on disturbance, the disturbance feedback factors ( 1zr , 2zr ) can be 
determined in the following way: 
 

• Set 11 −=z  (Step time: 10 sec), 02 =z , 01 =zr  and 02 =zr . 
• Run the simulation and calculate the disturbance feedback factor 1zr  with the help of 

the gain for the reference variable wr  and the steady-state error ( ) )(lim tete
t ∞→

=∞→ : 

( )∞→= terr wz1 . 
• The steady-state error should be zero, if you set the disturbance feedback factor 1zr  

and run the simulation again. 
• Now set 12 −=z  (Step time: 20 sec), 2zr  remains zero. 
• Run the simulation to determine the steady state error. Calculate the second 

disturbance feedback factor 2zr : ( )∞→= terr wz2  
• The calculated feedback factor is correct, if the steady-state error disappears, after 

setting the factor and rerunning the simulation. 
 
In case all parameters are complete for exercise 3.3.1 to 3.3.6, record and print the curves for 

)(tw , )(ty , )(te  and note the final values for IAE and ISE for each exercise. 
 
Pole placements for the experiment: 
 
 
3.3.1 4321 −=== λλλ  
 
 
3.3.2 5321 −=== λλλ  
 
 
3.3.3 ;41 −=λ  j243/2 ±−=λ  
 

3.3.4 ;41 −=λ  j443/2 ±−=λ  
 
 
3.3.5 ;4.61 −=λ  j243/2 ±−=λ  
 
 
3.3.6 ;21 −=λ  j443/2 ±−=λ  
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4 Analysis 
 
4.1 Performance indices IAE and ISE 
 
Give a formula for the calculation of each of the indices in the time domain. 

K=)(tIAE , K=)(tISE  
 
 
4.2 State control 
 
4.2.1 What is the necessary condition to apply state control? 
 
4.2.2 In exercise 3.3 the state variables are directly used to apply state control. 

If the state variables are not directly available, is there a possibility to apply state 
control anyway? 
If it is possible, give the name of the auxiliary tool that permits us to apply state 
control without direct access to the state variables and the necessary condition to apply 
the auxiliary tool itself. 
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Experiment 3: Decoupling of multivariable systems and 
 

nonlinear compensation control 
 
 
 
 
 

1 Theoretical Introduction 

1.1 The Decoupling of Multivariable Systems 
 
For the multivariable, coupled system 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
the control algorithms based on decoupling method must be found. 
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The coupled multivariable system with the decoupling controller should behave like 
two independent, uncoupled systems: 
 

 
 
 
 
 
A decoupling controller can be designed by executing the following 6 steps: 
 
 
• Step 1: 

Determine the differential order for every subsystem. (Every subsystem complies 
precisely with one output variable each) 
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• Step 2: 

 Calculate C* and D* 
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• Step 3: 
 Calculate the matrix D*-1 by inverting the matrix D*. 
  
The system is only decouplable if 
 
 det (D*) ≠ 0 
 
• Step 4: 

 Determination of the coefficients 
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with

ααα

ααα

δ

δ

=

=

−

−

lLl

MMM

lLl

1q,qo

1011,1101
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 due to the desired dynamics for the controlled overall system. 
 
• Step 5: 
 Set up the matrices L and M* 
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• Step 6: 

 Insert the calculated matrices into the control law: 
 
 u(t) = D*-1 (- C* x(t) + L w(t) - M* x(t) ) 
 
 
 
 
 
 

1.2 Direct application of the principle of the feedback linearization 
 
For a non-linear single input/output system 
 

 
( ) ( ) ( ) ( )
( ) ( )
&x t A x B x u t

y t C x

= + ⋅

=
 

 
the direct application of feedback linearization includes the following 4 steps:  
 
• Step 1: 

 The output equation is to be differentiated 
 
• Step 2: 

 Replace the derivatives of the state variables on the right side of the 
 differentiated output equation regarding the state differential equation. 
 

Step 1 and step 2 are to be repeated alternatingly until the right side of the 
(differentiated) output equation shows a direct dependence on a control 
variable. (The number of differentiations, which were carried out, 
corresponds to the differential order) 

 
• Step 3: 

 Carry out pole placement. 
 The number of poles should comply with the differential order. 
 
• Step 4: 

 Set up the control law by solving the equations regarding )(tu . 
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2 Preparation for Experiment  

(At home before you start the experiment) 
 
Attach the calculations for this chapter to the experiment results! 
 
2.1. For the multivariable, coupled system in state-space description 

 uxx ⎥
⎦

⎤
⎢
⎣

⎡
+⎥

⎦

⎤
⎢
⎣

⎡
−

−
=

03
21

31
12

&  

 xy ⎥
⎦

⎤
⎢
⎣

⎡
=

43
21

, Eq. 1 

a decoupling control system must be designed. Use the step by step 
procedure of the theoretical introduction (6 steps) for your calculation.  
 
Note: Use l1=1 and l2=3 in step 4. 

 
2.2. Declare the gain parameters for the system simulation shown in Fig. 1 (3.1.1). 
 
2.3. Evaluate a nonlinear controller by using feedback linearization described in 

theoretical introduction. The nonlinear equation system is 

 
xy

uxxx
=

⋅+= 2&
 Eq. 2 

The output equation in step 1 is  
 wyy =+&  Eq. 3 
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3 Experiment Procedure 

3.1 Decoupling of Multivariable Systems 

3.1.1 The structure of Eq. 1 is represented by a block diagram shown in Fig. 1 

 
Fig. 1: Block Diagram of a Multivariable Coupled System 

 
Enter the model shown in figure 1 in the SIMULINK editor and replace the gain 
parameters “-K-“ in the block diagram with the correct values in order to reproduce 
Eq. 1. 
 
Print out the model with the correct gain values. 
 
Print out the recorded curves for the following tasks (3.1.2 to 3.1.8). 
 

3.1.2 Record ( )ty1  and ( )ty2  as well as ( )tu1  and ( )tu2  with ( ) ( )ttu σ=1  and 
( ) ( )ttu σ22 = . 
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3.1.3 Record ( )ty1  and ( )ty2  as well as ( )tu1  and ( )tu2 , where ( ) ( )ttu σ=1  and ( )tu2  
is a pulse code with the parameters shown in Fig. 2 

 

 

Fig. 2: Block Parameters: Pulse Generator 

3.1.4 Extend the current system by a decoupling controller calculated in your 
preparation. 
Note: Use the “Fcn”-block from “Function & Tables”-Library and the “Mux”-block from the 

“Signals & Systems”-Library to build the controller. 
 
Print out the model extended with the decoupling controller. 
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3.1.5 Record ( )ty1  and ( )ty2  as well as ( )tw1  and ( )tw2  with ( ) ( )ttw σ=1  and 
( ) ( )ttw σ22 = . 

3.1.6 Record ( )ty1  and ( )ty2  as well as ( )tw1  and ( )tw2 , where ( ) ( )ttw σ=1  and 
( )tw2  is a pulse code in accordance to exercise 3.1.3 or Fig. 2. 

3.1.7 Design a corresponding simplified system, record and compare the outputs 
with the results from task 3.1.5. The signals for the reference variables are 

( ) ( )ttw σ=1  and ( ) ( )ttw σ22 = . Print out the model of the simplified system. 

3.1.8 Record the output of the simplified system with the following signals for the 
reference variables: ( ) ( )ttw σ=1  and ( )tw2  is a pulse code in accordance with 
Fig. 2. Compare the recorded curves with the results from task 3.1.6. 

 
 
 
 

3.2 Nonlinear compensation control 

3.2.1 The block diagram in Fig. 3 is described by following nonlinear differential 
equation system 

xy
uxxx

=
⋅+= 2&

 Eq. 2 

 
Fig. 3: Block Diagram of a Nonlinear System 

 
The initial condition of the integrator is 00 =x . 
 
Enter the model shown in figure 3 in the SIMULINK editor. Record ( )ty  where 
( ) ( )ttu σ= . Give a reason, why ( )ty  is zero during the simulation. 

 
Print out the recorded curves for the following tasks (3.2.2 to 3.2.3). 
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3.2.2 Double click on the integrator and change the initial condition of 0x  from 

00 =x  into 5
0 10−=x . Record ( )ty  where ( ) ( )ttu σ=  as well as ⎟

⎠
⎞

⎜
⎝
⎛= ttu

2
sin8)( π . 

Set the following parameters for the “Sine Wave”-block: 

 
Fig. 4: Sine wave parameters 

 

Is the system stable? 
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3.2.3 Extend the nonlinear system by calculated feedback controller in 2.3 and 
record ( )ty  where ( ) ( )ttw σ=  as well as ( )ttu sin)( = .  

Is the system stable now? Why is the amplitude of output signal lower than the 
amplitude of input signal? 
 
Note: Use the “Product”-block from “Math”-Library with parameters according to Fig. 5 to realize the 

division. 
 
 

 
Fig. 5: Product Parameters 
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4 Decoupling and feedback linearization 
 
4.1 Calculate the differential order 1δ  of the first subsystem 1y  of the following 

system given in state space form. 
 

 uxx ⎥
⎦

⎤
⎢
⎣

⎡
+⎥

⎦

⎤
⎢
⎣

⎡
−

−
=

02
74

51
23

&  

 uxy ⎥
⎦

⎤
⎢
⎣

⎡
+⎥

⎦

⎤
⎢
⎣

⎡ −
=

00
10

13
14

 

 
 
4.2 Use the principle of feedback linearization to evaluate a nonlinear controller for 

the following nonlinear system. 
 
 ( ) uxx += sin&  
 2xy =  
 
After applying the controller, the overall system should behave like a 1PT -Element. 
 
 wyy =+&  
 
Reinsert the equation of your controller into the equation of the system to verify your 
calculation. 
 
 
 
 
 
 


